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1 Die Konfigurations-Datei

Die Einstellungen der Wiederverwendungsbibliothek (Bibliotheks-
Namen, Pfade...) werden in einer Konfigurations-Datei (.krx) gesteuert /
gespeichert.

StandardmaRig liegt diese Datei im Installationsverzeichnis. Bei uns
entspricht das folgendem Pfad:
"C:\Siemens\NX9.0\NXPARTS\ReuseLibrary\Configure\
ReuseLibraryConfiguration.krx"

Es gibt drei mogliche Verzeichnisse, in denen eine solche KRX-Datei
beim Start von NX ausgelesen wird. Es kann auch in allen drei
Verzeichnissen gleichzeitig eine KRX-Datei liegen. Dabei muss eine
Reihenfolge beachtet werden:

« Die hochste Prioritat haben die Anwenderstandards. Hier kann der Datei > Dienstpro-

Pfad zu einer KRX-Datei festgelegt werden.

| Anwenderstandards b4
Standardstufe IAnwender Lq Freigegeben Einheitensystem
Cateway o [ ‘Wiederverwendbare Komponente " Befestigungsbaugruppe " Wiedervenwendbare Tasche]
Allgemein [ UDF-Bibliothek ” Symbolbibliothek H 2D-Schnitt-Bibliothek H Indexsuche I
Objekt Allgemein
Anwenderattribute 3
Benutzerschnittstelle AT T E‘ 7
Visualisierung
Filte
Facette - Einstellungen A IE E‘
gervur‘nebung - Einstellungen Wiederverwendungsbibliothek-Konfigurationsdatei Izl
itter
Ui
Anzeige i [l ]
Grundbeleuchtung = ||| windows | | [ purchsuchen |
Objektdarstellung bearbeiten
. y NX nativ
Ansichtenoperationen
Teile-Navigator @Wiederverwemdungsbibliothek anzeigen E‘
Baugruppen-Navigator Bibliotheken nach nativem Ordner anordnen @

(A R R StandardParts|SHEB_NX_SHARE/ReuseLibrary_abNX5/StandardParts

Stereo-Lithoaraphie LGSISHRR N¥ SHARF/Raeusal ibrary abhNX5/11GS

n

« Wurde in den Anwenderstandards nichts angegeben, greift die
KRX-Datei im Benutzerverzeichnis:
"C:\Users\BENUTZERNAME\AppData\Local\Siemens\NX90\
ReuseLibraryConfiguration.krx"
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File > Utilities >
Customer Defaults
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1 Die Konfigurations-Datei

* An letzter Stelle wird die Standard-KRX-Datei wirksam.
"C:\Siemens\NX9.0\NXPARTS\ReuseLibrary\Configure\
ReuselLibraryConfiguration.krx" (siehe oben)

il Optional kann in der Verwaltung der Wiederverwendungsbibliothek eine
Konfigurations-Datei nachgeladen werden.
Werkzeuge >

Wiederverwen- ‘B | Verwaltung der Wiederverwendungsbibliothek
e S
dungsbibliothek Bibliotheken
Veraltung der _
Wiederverwen-
dunnglbIIOthek Name Directary
= Folder
Tools > Reuse %
; LT
Library > Reuse e
Library =
Management

Eine nachgeladene KRX-Datei wirkt erweiternd.
D.h., Bibliotheken werden aus der nachgeladenen KRX-Datei in die
KRX-Datei, die beim Start ausgelesen wird, aufgenommen.

So kann man z.B. Bibliotheken an einen Kollegen weitergeben.

Beim Start geladene KRX nachgeladene KRX
Wiederverwendungsbibliothek wiederverwendungsbibliothek
Name Name
#-[% Reusable Object Library (Example Only) %% Reusable Object Library (Example Only)
+-pi1 20 Section Library + -l Mechatronics Concept Designer
+ - Mechatronics Concept Designer +-ffl StandardParts
+-f{fjl StandardParts = 8 UCs
- uCs 44[ = -§fl Training
+-fffl UDF Library

|
\

Wiederverwendungsbibliothek

Name

¥ _}rf Reusable Object Library (Example Only)
+-p31 2D Section Library

+ ﬁ Mechatronics Concept Designer

+-fffl StandardParts

+ UGS

[ +-fffl Training

+-fffl UDF Library
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2 Anlegen einer neuen Wiederverwendungsbibliothek

2 Anlegen einer neuen Wiederverwendungsbibliothek

Es gibt zwei Methoden, wie eine eigene Bibliothek angelegt werden
kann.

2.1 Uber die Anwenderstandards (Customer Defaults)

Diese Methode bietet die Moglichkeit die Bibliotheken zentral anzulegen.

@ Amwenderstandards % =

Standardstufe IAnwender F-! Freigegeben Einheitensystem
Gateway . - [ Wlederv.eru.vendbare Komponente. H Befestigungsbaugruppe H Wlederverwendbare Tasche } Datel > Dlenstpro_
Allgemein [ UDF-Bibliothek " symbolbibliothek H 2D-Schnitt-Bibliothek. " Indexsuche 1
Objek Allgemein ] gramme > Anwen-
Anwenderattribute
Benutzerschnittstelle (EEERED @ Tl derStandardS
Visualisierung §
Facette - Einstellungen =G E @ F_l > Ut_/ _t_
- Ei >
gervorhebung Emstelingen Wiederverwendungsbibliothek-Konfigurationsdatei @ I e I IeS
itter
uix ] | Customer Defaults

Anzeige

Grundbeleuchtung... windows [ | [ Durchsuchen

Objektdarstellung bearbeiten

) NX nativ
Ansichtenoperationen

mn

Teile-Navigator [w] Wiederverwendungsbibliothek anzeigen @
Baugruppen-Navigator Bibliotheken nach nativem Ordner anordnen
e Gl T Tl StandardParts|SHBB_NX_SHARE/ReuseLibrary_abNX5/StandardParts A
Stereo-Lithographie UGSISHBB_NX_SHARE/ReuseLibrary_abNX5/UG5 =
Plotten Reuse Objects|SUGI_BASE_DIR/NXPARTS/Reuse Libran/\Reusable Object Library

PlotTitel HBB-Bibliothek | C:\TRAINING\HBB_Bibliothek >

0

Zum Erstellen einer neuen Bibliothek wird eine zusatzliche Zeile im
markierten Bereich eingefugt:

IHEB-Bibliothekl[/|C-\TRAINING\HEBE_Bibliothek|
v A W

Pfad zum gewunschten

Name der Bibliothek Trennzeichen Bibliotheksordner

Tipp:
FUr die Pfadangabe kdnnen auch Systemvariablen verwendet werden.

Durch das Loschen der Zeile wird die Bibliothek wieder entfernt.

Nachdem NX 9 neu gestartet wurde, erscheint die neu erzeugte HBB-
Bibliothek in der Resource Bar.

Wiederverwendungsbibliothek ) -
Mame |Zl'7
+ _rH Reusable Object Library (Example Only) |
+-p471 2D Section Library 51
+-ffl Mechatronics Concept Designer ——
+-fffl StandardParts al—a
= UGS L
+.{f§ HBB-Bibliothek ﬁ
+-{fg UDF Library o
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2 Anlegen einer neuen Wiederverwendungsbibliothek

iy

Werkzeuge >
Wiederverwen-
dungsbibliothek >
Veraltung der
Wiederverwen-
dungsbibliothek

Tools > Reuse
Library > Reuse
Library
Management
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2.2 Mit Verwaltung der Wiederverwendungsbibliothek (Reuse
Library Management)

Diese Methode bietet die Moglichkeit eine Bibliothek schnell anzulegen
und zu bearbeiten.

In diesem Menu sind alle Bibliotheken aufgelistet.

Bei den hier ausgegrauten Bibliotheken handelt es sich um Standard-
Wiederverwendungsbibliotheken, welche in den Anwenderstandards
definiert werden (siehe 1.1). Diese kann man an dieser Stelle nicht
bearbeiten.

Bibliotheken A

Bl

| Bibliothek hinzufiigen

Directory

- UDF Library

- Custom Symbol Library
- Moldwizard

. ProgressiveDieWizard
+-[%f EngineeringDieWizard
. StampingDie

# [ Electrode

OK l [ Abbrechen
]

Wenn eine neue Bibliothek angelegt werden soll, muss zuerst der Ort in
der Wiederverwendungsbibliothek angegeben werden (hier Folder).

Daraufhin  Bibliothek hinzufiigen (Add Library) wahlen und das
gewunschte Verzeichnis angeben.
AnschlielRend kann noch ein Name fur die Bibliothek vergeben werden.

i
8| HeB-Bibliothek

CATRAINING
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2.2 Mit Verwaltung der Wiederverwendungsbibliothek (Reuse Library Management)

Mit <MB3> auf Anwendungsaufgabe (Application Task) kann
angegeben werden, in welchen NX-Anwendungen (NX-Applications) die
ausgewahlte Wiederverwendungsbibliothek vorhanden sein soll.

Bibliotheken Al

x al >}
[l ][] (=)}
Name Directary
= Folder AnwendungsaufgabeJ
*

v

(o Anuendungen ———— 15

[ Mo Part

[ Gateway

W Modeling

[ Drafting

1 Manufacturing
[1 Shape Studio o

m| »

Die Bibliothek wird immer in diejenige Konfigurations-Datei
aufgenommen, die wirksam ist (siehe 1.1).

Achtung:

Sollte eine KRX-Datei im Installationsverzeichnis
("C:\Siemens\NX9.0\...) liegen und die neue Bibliothek wird in dieser
Datei angegeben, qilt folgendes:

Wird die Bibliotheksverwaltung aufgerufen, kann die selbst erstellte
Bibliothek nicht mehr bearbeitet werden (sie ist ausgegraut).

6 Verwaltung der Wiederverwendungsbib

Bibliotheken

X[=)[E[£)

Mame Directory
= Folder

=1.F LINF Library
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3 Zusammenfassung

Seite 6/ 14

3 Zusammenfassung

An folgenden Stellen kann die Konfigurations-Datei angegeben werden
(geordnet nach Prioritat; siehe 1.):

Anwenderstandards (Angabe eines beliebigen Verzeichnisses)
* Benutzerverzeichnis

* |nstallationsverzeichnis

*  Verwaltung der Wiederverwendungsbibliothek (Nachladen eines
beliebigen Verzeichnisses)

An folgenden Stellen kann eine neue Wiederverwendungsbibliothek
angelegt werden:

* Anwenderstandards (siehe 2.2)

* Verwaltung der Wiederverwendungsbibliothek (siehe 2.3)
* Konfigurations-Datei
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4 Erstellen eines wiederverwendbaren Teils

4 Erstellen eines wiederverwendbaren Teils

In NX besteht die Mdglichkeit Objekte (Object) (wie z.B. Fldchen (Face),
Koérper (Body), Formelemente ((Feature) usw.) als wiederverwendbar zu
definieren.

G_} Wiederverwendbares Objekt ’?R

Typ A

(] Flache

| Korper o
-0, Formelement

41 2D-5chnitt

# Allgemein

[ Teil

& Als Schaltflichen anzeigen

@ [# Reusable Object Library (Example Only|~
(-3 2D Section Library ‘

- Mechatronics Concept Designer
=-fff StandardParts

=-{§ UGS

K| HBE-Bibliothek [=

< | T | 2
Name v
Bildvorschau v

[—BIH [ Abbrechen

4.1 Wiederverwendbare Komponente

In diesem Fall wird als Ausgangsteil ein einfacher Stift verwendet.

Die spater zu verandernden Parameter sollten mit sinnvollen Namen =
versehen werden.

6 Ausdricke |§ Werkzeuge >
Ausdruck
Aufgelistete Ausdriicke
IBenannT L‘q i
Tools > Expression
Name & Formel | Wert | Einheiten  Typ Aktualisiert
Durchmesser (Zylinder(3) Durchmesser) 5 5 mm Anzahl «°
Hohe (Zylinder(3) Hohe) 30 30 mm Anzahl +°
TVD|AnzahI @ [Lé’mge a
Name J[mm 2]
For‘mel[ ]@ v [

[0k || Anwenden || Abbrechen |
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4 Erstellen eines wiederverwendbaren Teils

Werkzeuge > Nun muss eine Teilefamilie (Part Families) angelegt werden um die
Teilefamilien verschiedenen Varianten zu bestimmen.
Tools > Pan‘ 5 Teilefamilien ,jﬁ
Families Spalten A
Verfligbare Spalten [Ausdrucke E!
Name
Hohe Ei
p26 i
p37
p38
::n|n T 3
Aktionen A
N Die gewunschten Spalten (Columns)
— l hinzufiigen.
Aus ten
— Add at End
I*«Ial..,—.laT ! Typ
DE_PART_NO @'
0S_PART_NAME =
Eﬂfhc*“me“ef In der Excel-Tabelle missen nun die
== verschiedenen Varianten des Stiftes
bestimmt werden.
Aktionen v A B C D
bellenkalkulati - 1 |DB_PART_NO OS PART NAME Durchmesser Hdohe
Tabellen ulation 2 71 Stift5 x5 5 5
Create Spreadsheet i 3 2 stift 5x 10 E 10
a3 Stift 5 x 15 5 15
Einstellungen v 5 (4 Stift 5 x 20 3 20
ok [ Abbrechen | 6 5 stift5x25 3
7 |6 Stift 5 x 30 5 30
g 7 Stift 5 x 35 5 35
q 'ﬂ ctift 5 v AN = AN

Nachdem die Varianten in die Tabelle eingetragen wurden, muss die
Familie abgespeichert werden.

Die Familienmitglieder mussen nicht erzeugt werden, sie werden
automatisch nach Bedarf erstellt.

Ca
]

Start Einfagen Seitenlayout Formeln Daten Uberprifen Ansicht Add-Ins

Teilefamilie ~

Teil aberprifen

Werte anwenden

Teile aktualisieren

Teile erzeugen ‘ I | 1

Familie speichern B C D E F G

Abbrechen ART NAME Durchmesser Héhe
2 ]'1 Stift5x5 3 3
3 L2 Stift 5x 10 5 10
4 L3 Stift 5x 15 5 15
5 L4 stift 5% 20 5 20
] ti stift5x 25 3 25
7 LE Stift 5x 30 3 30
3 L? Stift 5x 35 5 35
a la CHift B v AN 5 An
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4.1 Wiederverwendbare Komponente

Das Part muss nun noch in der Wiederverwendungsbibliothek
(Verzeichnis) abgespeichert werden.

;E.L|
- <« Reus... » HBB-Stift ~ | 45 [ HB8-Stit durchsuchen

Organmeren - Brennen MNeuer Ordner

-

i Favonten =

B Desktop |ﬂ 06.08.2013 15:29 UG Part File

5] Zuletzt besucht

Name Anderungsdatum Typ

4 Bibliotheken

[ Bilder

Wiederverwendungshiblio... @ :

Name I]fJ

8 ﬁ HBE_Bibliothek -~
Nach dem Aktualisieren der Bibliothek 51
oder evil. einem Neustart von NX wird 'f' i UDF Library S|
das Teil in der Bibliothek aufgelistet. ~ @G HeB UDF Fo

~ ®-[Fg UGS UDF 3
E:I--ﬁ Custom Symbaol Library
|¢:| £ HBB-Symbale
----- ‘g Part Symbols

m

4 I k

Suchen v

Mitgliederauswabhl A

@@ |‘ 1-1 von 1

_

=

Stift

Mitgliederauswahl A h

4 1von] b <MB3> > KRX-Datei erzeugen (Create

- KRX file)
3, 5 auf das gewunschte Mitglied um eine
|7 20 Baugruppe inzufigen | Definitionsdatei anzulegen.
* % Offnen
= Ausschneiden ]
By Kopieren
B KRX-Datei erzeugen ]
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4 Erstellen eines wiederverwendbaren Teils
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Ausgabe A
Ausgabedatei
S:\Schulungs_hbb\assemblv\Reuse_Librar\f\Reuse_Libra] @
Dateien A
Teil
Stift prt | @
@ Primdre Parameter A
Legendenabbildung
[ HBB-stift_Logo.bmp | (2]
Hohe g5 -
Familienelement-Speicherverzeichnis
[ S:\Schulungs_hbb\assemva\Reuse_Librar\f\Reuse_Library] @ > Details A
P MName Wert
Primare Parameter A
DE_PART_NO 139
DB_PART_NO Parameter | Beschreibend @ 0S_PART_NAME Stift 35x 95
OS_PART_NAME
Durchmesser Durchmesser Durchmesser 35
Durchmesser B B - -
Héhe Hohe Hohe Héhe 95
z - = . 4 1 3
Automatische Ubereinstimmung M
Platzierung ¥
Durchmesser L. " - - Ei
MNachst grolte oder gleich (==)
O = L l < ¢ Tasche v
ONachst kleinste oder gleich (<=) = - v
instellungen
(@ Gleiche Groke ivie(=l | 2
Vorschau v
[ oK H Anwenden ][ Abbrechen ] OK H Abbrechen ]
e
Die rechte Abb. zeigt den Dialog, der beim Einfugen der

wiederverwendbaren Komponente gedffnet wird.

Ausgabe (Output)
Hier muss der KRX-Dateiname/Dokumentname (KRX file name/Dataset
name) angegeben werden.

Dateien (Files)

Unter dem Reiter Dateien (Files) kdnnen noch z.B. ein Bild fur die
Legendenabbildung (Legend Image), die beim einfugen erscheint
eingefugt werden.

Hier kann auch noch ein Speicherverzeichnis (Save Directory) fir noch
nicht erzeugte Familienelemente (Family Members) angegeben werden.

Primére Parameter (Primary Parameters)

Im Abschnitt Primdre Parameter (Primary Parameters) kdnnen
Ausdriicke hinzugefugt werden, die beim Einfugen des Teils als
Einstellung verflgbar sein sollen.

Automatische Ubereinstimmung (Auto-matching)
Mit Hilfe von Automatische Ubereinstimmung (Auto-matching) kann
eingestellt werden, dass sich z.B. der Stift an die Bohrung (Hole), in die
dieser eingefligt werden soll, automatisch angepasst.
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4.2 Wiederverwendbares Objekt

4.2 Wiederverwendbares Objekt

Als erstes wird nun ein neuer Ordner (new Folder) zur HBB_Bibliothek

hinzugeflugt.

In diesem Ordner soll das neu erzeugte wiederverwendbares Objekt

spater abgelegt werden.

Wiederverwendungshibliothek @
Name
[=Fii: | HBB_Bibliothek -

Aktualisieren

= ﬁ

Ausgangsordner offnen

[+

Einfiigen

Wiederverwendbares Objekt definieren

@ Knoten unterhalb dieser Stelle durchsuchen...

[+
.o B —>

{8 HBB_Bibliothek
Cg HEB-Langloch
£ HBB-Stift

T Wiederverwendbares Objekt ’FR

Typ

[:9; Allgemein

Objekt

+ Objekt auswahlen (1)

| Attribute

><H>E>

Ordneransicht

Name
=-fffl StandardParts -
=gl UCs
-l HEB-Bibliothek
- wiederverwendungsbibliothek
-l HEB-Biliothek_2
= |l HBE_Bibliothek

e| HBB-Langloch

£ HBB-Stift =
4 n | 3

m

Name A

Beschreibender Name
[HEB_LangIoch ]
Teiledatei

[ Langloch_export.prt

Bildvorschau

|

A

Eingabe [Datei m

Bilddatei

[ S:\SchuIungs_hbb\assemblv\Reuse_Librar\_,]
A

Bildvorschau

I—QK—H Abbrechen ]

Das Langloch kann nun als
wiederverwendbares Objekt definiert
werden, hierzu muss der Typ (Type)
auf Allgemein (General) umgestellt
werden.

Ordneransicht (Folder View)

Es muss eine Bibliothek (z.B. ein
Ordner einer Bibliothek) angegeben
werden, in welchen das gewlnschte
Objekt abgelegt werden soll.

Name
Der Beschreibende Name (Descriptive
Name) wir bei der Mitgliederauswahl
(Member  Select) unterhalb des
Mitgliedes angezeigt (siehe unteres
Bild).

Bildvorschau (Preview Image)

Zur besseren Darstellung kann
wahlweise ein Bilddatei (Image File)
angegeben werden.

© 1999 — 2014 HBB Engineering GmbH - All rights reserved
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Werkzeuge >
Wiederverwen-
dungsbibliothek >
Wiederverwend-
bares

Objekt definieren

Tools > Reuse
Library >

Define Reusable
Object
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4 Erstellen eines wiederverwendbaren Teils
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Nach Beenden dieser Funktion, ist das Wiedervenweniunyshitlio 0 o
Objekt in der gewahlten Wiederverwen- Name

dungsbibliothek verflgbar. = [ -ee_eibliothek -
[##| HBB-Langloct

P HBB-Stift
=I-ffl UDF Library
+.Cg HEB UDF
4.3 UGS UDF
=I-fffl Custom Symbal Library 3
+-Fg HBB-Symbole

Cg Part Symbols -
4 L1} 2

il

S E EICNEENY] & [FFTE

Suchen v

>

Mitgliederauswahl

Feature/Object Templ... | =

HEB_Langloch

Tipp:

Wenn die Auswahl mittels des Typs Allgemein (General) von statten ging
kann dem wiederverwendbaren Objekt eine Excel-Tabelle hinzugefugt
werden.

Dadurch kann dieses ahnlich wie eine Teilefamilie behandelt werden.

Das Layout der Tabelle muss so aussehen.

A B C
1 BITMAP
2
3 PARAMETERS
4 Breite (B) Laenge (L) Hoehe (H)
5 25 50,75,100,125,150,175,200,225,250,275,300 25,50,75,100,125,150,175,200,225,250,275,300
[ 50 75,100,125,150,175,200,225,250,275,300 25,50,75,100,125,150,175,200,225,250,275,301
7 75 100,125,150,175,200,225,250,275,300 25,50,75,100,125,150,175,200,225,250,275,3202
8 100 125,150,175,200,225,250,275,300 25,50,75,100,125,150,175,200,225,250,275,303
9 END

Verschiedene Auswahlimoglichkeiten kénnen mit einem Komma
definieren.

Achtung:
Grof3- und Kleinschreibung und Rechtschreibung der Parameter
beachten!!!

Wichtig:
Diese Tabelle muss selbst erzeugt werden und in das selbe Verzeichnis
mit dem selben Namen wie das Objekt abgespeichert werden .

i5] Langlech_export.xlsx
@ Langloch_export.prt
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5 Einfiugen eines wiederverwendbaren Objekts

5 Einfugen eines wiederverwendbaren Objekts

5.1

In einer Baugruppe

Um eine wiederverwendbare Teil in die EICECIEICCIERCHEIE
Baugruppe (Assembly) einzufligen, muss das | Legende A
.. : ey
gewlnschte Teil aus der )
Wiederverwendungsbibliothek per Drag and INE
Drop in den Grafikbereich gezogen werden. ““’\ =
Primire Parameter A
Durchmesser [20 -
Héhe [s0 .
Details A
Mame Wert
DE_PART_NO 70
OS_PART_MNAME Stift 20 x 50
Durchmesser 20
Hihe 50
4| 1 +
Das Fenster (links) wurde mit Hilfe der krx- | ;. iciung -

Datei angelegt.

Primare Parameter
Angabe der Wert der wiederverwendbaren
Komponente.

Details
Hier werden alle Parameter aufgelistet, die in
der Teilefamilie erzeugt worden sind.

Platzierung (Placement)

D Ermittelte Zwangsbedingungen verwenden

Es kann angegeben werden,
wie die Komponente platziert
werden soll.

© 1999 — 2014 HBB Engineering GmbH - All rights reserved

Absoluter Ursprung
Ursprung auswahlen

MNach Zwanagsbedingungen
Verschieben

Mehrfach laden [Kein Lv_.!
Positionierung [Nach Zwangsbedinglﬂ_-l
Menge in jeder Operation
i s
Richtung umkehren
Tasche v
Einstellungen A
Name [sTIFT 20 x 50 |
Reference Set [I\"'Ic:del["l'\-"IICJDEL"II L'_-l
Layer-Option [On’ginal Lv_.l
1

[wf] Vorschaufenster anzeigen

Vorschau v

0K ’ [ Abbrechen
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5 Einfugen eines wiederverwendbaren Objekts
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Zieht man die Komponente direkt auf die geforderte Flache (Bohrungs-
Innenflache), wird diese automatisch an z.B. den Durchmesser
angepasst.

Primédre Parameter A |
_> IDurchmesser [20 'ﬂl
Hohe [5 =

Achtung:
Eine Anpassung (wie in diesem Fall mit dem Durchmesser) findet nur
statt, wenn dies in der krx-Datei eingestellt wurde.

5.2 Im Einzelteil

Grundsatzlich verhalten sich Objekte, die Uber die Wiederverwendungs-
bibliothek in ein Einzelteil eingefugt werden, &hnlich wie beim
Hinzufiigen mit Copy and Paste.

Orientierung A
L o Unter' dem Punkt __Detailpa_;rameter
(Detail Parameters) kbnnen die in der
EE Rl ~| Tabelle definierten Werte eingestellt
Name Wert werden.
i wE 75
SRl 175 . .
-5 v vl | Mit dem Button Datenbank bearbeiten
25 - (Edit Data Base) kann die Excel-
75 Tabelle bearbeitet werden.
100
125 |5
150
175
200 =
Einstellungen ggg il v
0K I[ Anwenden ][ Abbrechen
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